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Are you ready for Y2K or data recovery?

by Charlie Moore

We are fortunate to have Chris Doyle
from Ontrack make the presentation at
our August 10 meeting.

Who is Ontrack, you
say? In the early days,
when your BIOS (Basic
Input/Output System)
would not support an
add-on
hard drive
(no User
Type 47) or
the BIOS
did not
support
larger hard
drives, the
only way to
go was use
a hard drive
partitioning
software program called Disk Manager.
Today, I still use it for a couple of PC
manufacturers, who I won’t mention
here but whose names start with “C”
and “P.”

Now, Ontrack is a world leader in
data recovery. Besides traditional in-lab
recovery, they also have do-it-yourself
recovery software and utility programs
such as Data Advisor, Y2K Advisor,
and Disk Manager DiskGo!

In addition, they have recently
acquired Mijenix; maker of popular
programs such as Fix-It, Utilities 99,
Zip Magic 98 and others that run on the

Windows 95/98/NT platforms. They are
now at www.ontrack.com.

Chris is an
Applications Engi-
neer Supervisor
based in Ontrack’s
Costa Mesa office.
He has been with
Ontrack for two

years and his function is two-
fold. He divides his time be-
tween their “clean room” and
lab, performing data recovery,
and in the field performing
training, engineering liaison and
other functions. He also man-
ages other engineers with similar
duties in other branch offices.
He has worked with com-
puters
his

entire career,
starting with
IBM main-
frames and
moving to
PCs,
servers,
AS400s, etc.

Chris likes
to talk about
hard drive
issues,
viruses and

“Ontrack Y2K Advisor 2.0
is my top hardware
testing choice—it’s easy
to use, informative, and
well-priced.”

Jim Aspinwall
Computer Currents

(Continued on page 11)
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Letters to the editor

!!!!! Auction action gets wild

I’ve entered the world of eBay auc-
tions. Quite a “wild and wooly” place!
I thought I got a real deal on Calen-
dar Creator 6 ($15), but shipping was
$8 and the company doesn't take
credit cards (another $5 for a money
order).

Then I found I could have pur-
chased the program from another
company for just $11 and they do
take credit cards! I guess you should
look before leaping, but as the “boys”
seem to want “calendars” and CC is
good at producing them (I do have
CC 4—but on about 14 floppy disks)
I decided I should get the latest
version.

I bought a few packages from a

company in California (Kai's Power
Goo and a few games) for next to
nothing. They had a “3 pack” of the
“You Don't Know Jack” game, and I
bid $20 for it. The auction was almost
over and nobody had placed a bid on
this item for days. Suddenly I heard a
“ping” indicating the arrival of an e-
mail message. I had been outbid. I
frantically raced back trying to make a
new bid.

Too late. The auction had closed.
A “weasel” <g> had bid $20.01.

Paul Stephen, editor
Winnipeg PC User Group

editorpaul@wpcusrgrp.org

N&B wins again!
by Linda Gonse

Nibbles & Bits won First Place in the
newsletter contest held at the South-
west Regional User Group Confer-
ence, July 9-11, in San Diego.

Sponsored by Adobe, the contest
was divided into two newsletter cate-
gories. Nibbles & Bits was the winner
in the 12 pages or less category, fol-
lowed by: Long Beach IBM PC
Users Group, Santa Clarita Valley PC
Group, and Temecula Valley Com-
puter Users Group. Ten newsletters
competed in the category.

Life surprised me again. A notice
inside my Windows’ magazine said it
was the last printed issue. What hap-
pened? I asked T.J. Lee, publisher of
an online newsletter, The Naked PC.

“The problem is twofold,” he said.
First, he said, there were too many
computer magazines competing for
the public’s attention—not all surviv-
ed. Secondly, people are finding free
information on the Internet and aren’t
subscribing as much to print maga-
zines. Now, advertisers are dividing
their dollars between print and online
periodicals. Many  major printed
magazines have had to make cuts in
staff and other areas.

Windows probably made the
biggest cut of all. It will continue
online, but in what form? It’s difficult
to say. My subscription was good
through June 2000, because I thought
it was a useful, interesting magazine.
Only, I doubt I’ll spend much time
with the online version. I like to relax
with a magazine, a Diet Coke and a
bowl of popcorn. You can’t do that
while scrolling and clicking.

And, there’s little chance I’ll be
printing out those pages to read later,
either. If all the magazines I subscribe
to go online and I printed them out,
my laser cartridge expenses would
probably double or triple.

What’s the answer for readers? I
don’t know. This whole situation is in
a state of flux. Online publications are
fine, but so is print. There is a place
for both. At least, I hope there is.

How do you feel about reading
major magazines online? And, how

would you feel about Nibbles & Bits
being online? (There are no plans, but
some user groups have converted
print newsletters to online issues as an
answer to their fiscal problems.)

Write linda@orcopug.org, I’d
really like to read your comments.Windows magazine: RIP

mailto:orcopug@prodigy.com
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June 1 Vince Cimino
Lynn Herbert

July 1 Herman Beverburg
August 1 Gloria Bearss

Don Faisy
Stan Leese
Sid Liptz

September 1 Bob Clark
Arnold Francis
Mervin Frank
Duane Gifford
Bob Greback
Dave Tennant

October 1 Alan Jarrett
Larry Klees
Myra Milgrom

November 1 Randy Bremer
Robert Chenoweth
Helen Desmond
James Southall

Submitted by Charlie Moore

18 win in July raffle

Novell
Tool Kit Value $10
David Musser Winner

PowerQuest
DataKeeper Value $69
Carl Apponyi Not Present
James Southall Not Present
Arnold Francis Not Present
Terry Schiele Winner

MicroLogic
Info Select Value $79
Tony Lake Winner

Wild File
GoBack Value $79
Dick McMillan Not Present
Pat McMillan Not Present
Alan Jarrett Not Present
Frank Balazs Winner

Bingo Mania Value $50
Lynn Herbert Expired
Dan Sheffield Not Present
Rhett James Not Present
Herman Beverburg Expired
Joe Duffner Not Present
John Moore Not Present
Carl Apponyi Not Present
Lloyd Boutwell Not Present
Art Bullis Not Present
David Musser Prev. Winner
Monte Holmes Not Present
Dean Kise Not Present
Arnold Francis Not Present
Charlie Moore Winner

Shattered Steel Value $49
Larry Klees Winner

Parsons Technology
Super Sketch Value $20
Sharon Graham Not Present
David Musser Prev. Winner
Walter Jackson Winner

Computer Cookies Value $5
Larry Joyce Not Present
Glenn Emigh Not Present
Walter Jackson Not Present
Michael Lyons Declined
Pat Kennedy Not Present

Larry Klees Prev. Winner
Denny Turner Winner

Parson’s Techology
Home Inventory Value $20
Randy Bremer Winner

Novell
Cup Value $5
Win Corey Not Present
Daniel Cadish Winner

RogersTechology
Note Holder Value $5
Tony Lake Prev. Winner
Carl Westberg Winner

Para Techologies
Stretch Break Pro Value $39
Larry Klees Prev. Winner
Rhett James Not Present
Linda Gonse Winner

Rogers Technology
Note Holder Value $5
Daniel Cadish Prev. Winner
Monte Holmes Not Present
Pat Kennedy Not Present
Elmer Thomas Not Present
Carl Westberg Prev. Winner
Dick McMillan Not Present
Frank Balazs Prev. Winner
Art Bullis Not Present
Robert Kambeitz Winner

Parson’s Techology
Home Inventory Value $20
Don Faisy Not Present
Dean Kise Not Present
Daniel Cadish Prev. Winner
Elmer Thomas Not Present
Robert Kambeitz Prev. Winner
Monte Holmes Not Present
Lothar Loehr Winner

PowerQuest
DataKeeper Value $69
Carl Apponyi Not Present
James Southall Not Present
Arnold Francis Not Present
Terry Schiele Winner

Rogers Technology
Note Holder Value $5
Linda Gonse Prev. Winner
Ralph Seymour Not Present
Duane Gifford Not Present

Ralph Hedges Declined
James Southall Not Present
Vince Cimino Expired
Herman Beverburg Expired
Lloyd Boutwell Not Present
Leroy Kaump Winner

UCSD
Healthcare Value $5
Lothar Loehr Prev. Winner
Robert Kambeitz Prev. Winner
Joe Gionet Winner

Computer Cookies Value $5
Glenn Emigh Not Present
Joe Duffner Not Present
Joe Francis Winner

Computer Cookies Value $5
Ralph Seymour Not Present
Pat Kennedy Not Present
Larry Klees Prev. Winner
Sid Liptz Not Present
Duane Gifford Not Present
Jim Brubaker Winner

Submitted by Mike Lyons

Annual membershipAnnual membershipAnnual membershipAnnual membershipAnnual membership
renewal datesrenewal datesrenewal datesrenewal datesrenewal dates

My goal, as I get older, is to look
more distinguished without becoming
extinguished!

Submitted by Stan Leese
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Boutwell, Lloyd
................................... LloydB8@aol.com
Bullis, Art
...................................... bullis@juno.com
Brubaker, Jim
........................... info@1homeseller.com
Chenoweth, Bob
............................ Chenoweth1@aol.com
Cimino, Vince
.......................................... capov@pe.net
Emigh, Glenn
............................. consulting@emigh.net
Frank, Mervin
.............................. mervinf@net999.com
Gonse, Cynthia
..................................... cgonse@aol.com
Gonse, Linda
.................................. linda@orcopug.org
Graham, Sharon
......................... shgraham@earthlink.net
Don Hepler
........................ dwhepler@neumedia.net
Jarrett, Alan
.................................. alten101@aol.com
Kaump, LeRoy
.......................... MSPF38A@prodigy.com
Kise, Dean
........................................ okise@ibm.net
Klees, Larry
..................................... LKlees@aol.com
La Mont, Bill
............................ WILLARD47@aol.com
Lake, Tony
...............................TonyLake@juno.com
Leese, Stan
......................... stan_leese@surfside.net
Lyons, Mike
.................................. mike@orcopug.org
Milgrom, Myra
....................... WriteOnBiz@earthlink.net
Moore, Charlie
............................... charlie@orcopug.org
Moore, Chuck
........................ chuckmoore@home.com
Musser, Dave
......................... FGXR84A@prodigy.com
Schiele, Terry
................................... terry@orcopug.org
Thomas, Elmer
...................................... elmert@aol.com
Tooley, Richard D.
............................... tooley@alum.mit.edu
Wann, Harold
................. WANN.HSW@worldnet.att.net
Westberg, Carl
.................................... carl@orcopug.org
Wirtz, Ted
................................... twirtz@pacbell.net

E-mail directory

Cynthia Gonse ............................................................. Windows ’95-’98, Office 97
Anytime—cgonse@aol.com
Linda Gonse ........................... Windows ’95-’98, Office 97, PageMaker, Internet
(909) 245-0291 after 5 p.m. and weekends—linda@orcopug.org
Sharon Graham ........................................ MS Office, Access, Win 3.1, MS-DOS
(714) 533-6043 after 7a.m., before 10 p.m.—shgraham@earthlink.net

Members’ helplineMembers’ helplineMembers’ helplineMembers’ helplineMembers’ helpline

Add your e-mail address to the list
above. Print your information and

send it to Linda Gonse,
editor@orcopug.org, or give it to

her at the regular meeting.

Is it better to be a jock or a nerd?

When he was playing, Michael Jordan made over $300,000 a game. That was
$10,000 a minute, at an average of 30 minutes per game. With $40 million in
endorsements, he made $178,100 a day, working or not.

If he slept 7 hours a night, he made $52,000 every night.
If he decided to have a 5 minute egg, he’d make $618 while boiling it.
He made $3,710 while watching each episode of Friends.
If he wanted to save up for a new Acura NSX  ($90,000) it would have

taken him a whole 12 hours.
He probably paid around $200 for a nice round of golf, but was reim-

bursed $33,390 for that round.
If you were given a penny for every 10 dollars he made, you’d be living

comfortably at $65,000 a year.
While the common person is spending about $20 for a meal in Michael’s

trendy Chicago restaurant, he’ll pull in about $5600.
 Last year, he made more than twice as much as all U.S. past presidents for

all of their terms combined. Amazing isn’t it?
However, if Jordan saves 100% of his income for the next 250 years, he’ll

still have less than Bill Gates has today.
Game over. Nerd wins.

Submitted by Ted Wirtz

Signs you’ve become hopelessly computerized…

• You try to enter your password on the microwave.
• You haven’t played solitaire with a real deck of cards in years.
• You e-mail your son in his room to tell him that dinner is ready, and he

e-mails you back, “What’s for dinner?”
• Your daughter sells Girl Scout Cookies via her web site.
• You chat several times a day with a stranger from South Africa, but you

haven’t spoken to your next door neighbor yet this year.
• You didn’t give your valentine a card this year, but you posted one for your

e-mail buddies via a Web page.
• The concept of using real money, instead of credit or debit, to make a

purchase is foreign to you.
• Your reason for not staying in touch with family is that they do not have

e-mail addresses.
• You consider 2nd day air delivery painfully slow.

“Common sense is instinct. Enough of it is genius.” — George Bernard Shaw

Submitted by Fred P. Coad

mailto:shgraham@earthlink.net
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Ken’s
Korner

by Ken
Fermoyle

How to print selected
material from web pages

First, as in making Rabbit Stew, you
must catch the rabbit! In this case,
before you can print sections of text
from Web pages you must first select
the material, then paste it into an
appropriate software program (e.g.
WordPad, any word processor, MS
Publisher, etc.). Do that by following
these steps. (Selecting and Printing
graphics is covered toward the end of
this article).
1. Select desired text material in the
normal manner by setting your cursor
at the upper left corner of the text and
holding down the left mouse button.
Continue holding the button down and
drag the cursor to the end of the
material you want to select, then
release the button. Your selected text
should now be highlighted.
2. Go to the Edit Menu at the top of
your screen and click on Copy (or use
the Control-C keyboard shortcut). If
you don’t already have the target
software application open, open it now
via the Start Menu or a shortcut icon
on your Desktop.(Let’s assume you
will use WordPad from the Accesso-
ries Group in the Start Menu. It’s quick
and easy, and everyone who uses
Windows 95/98 has it available.)
3. Go to the File Menu and click on
New to open a new document.
4. Make sure the blinking insertion
pointer (vertical bar) is positioned at

the upper left of the blank page.
5. Go to the Edit Menu and click on
Paste (or use the Control-V keyboard
shortcut). The selected material should
now appear on the blank page.
6. Now you can either save the text
(using Save As from the File Menu),
edit it to reformat some of the text or
to remove unwanted material, or print
it (by going to the File Menu and
selecting Print).

I do this all the time. Frequently,
when researching a subject for a
future article, I first create a file by
following steps 3 and 4, typing in just
a title and perhaps a few notes at the
top of the page, then I use File/Save
As to give the file a name and save it
in an appropriate folder. I visit various
Websites, select helpful material and
use Copy/Paste (steps 1 through 5) to
insert it into the previously created
file.

I often use WordPad for this, but
MS Word, Word Perfect or some
other word processor that offers a
Find or Find/Replace function may be
preferable if
you
assemble a
large amount
of text in a
single file.
Such
software
allows you to
search for a
word or
phrase quickly and easily when
necessary.

The process for selecting and
Printing material from e-mail is the
same. Follow the same Copy, Paste,
Print sequence outlined above.

If you want to print an entire Web
page, simply click on the right mouse
button anywhere on the page. Select
Print from the pup-up menu that

 …before you can print
sections of text from Web
pages you must first select the
material, then paste it into an
appropriate software program.

appears and follow normal Printing
procedure.

If you want to print a picture or
other graphic from the Web, do this:
1. Place cursor on designed image.
2. Click right mouse button.
3. Click on Save Picture As
4. Select the drive and folder where
you want to store the graphic.
5. Save it under the original name, or
give it a new name.

You can then print the graphic by
importing it into an appropriate image
editing program (e.g. Windows Paint,
Photo Deluxe, Photo Shop, Photo
Impact, etc.). Reminder: Web images
are normally in low-resolution GIF of
JPEG formats so they will not look as
good when Printed as BMP, TIFF or
other higher resolution images.

A tip here: If you’re only interested
in printing out the text on a page, just
turn off the graphics. In Internet
Explorer follow these stops.
1. On the View menu in the browser,
click Internet Options.
2. Click the Advanced tab.
3. Select the Multimedia tab, and

remove
checks in
the Show
pictures,
Play anima-
tions, Play
videos, and
Play sounds
check
boxes.

This will
make Web pages load a lot faster,
too. You can always turn the pictures,
animations, etc. back on by reversing
the procedure.

Actually, what I do is use two
browsers an older version of
Netscape Navigator with graphics
turn off, and a current version of
Internet Explorer with all the goodies
turned on.

(Continued on page 10)
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Software review

DriveCopy, Version 2:
A great tool when
you need it

by Willard La Mont
There are many generally useful
program packages on the market
today. Then there are others that are
useful for special activities. And then
there are some that are not just
useful, but essential. Partition Magic
is one of those, and DriveCopy is
another.

DriveCopy, made by
PowerQuest, is easy to install, just
follow directions in the well-written
manual. It is intended for the user
who, like so many of us, needs to
keep what he has on his old hard
drive and transfer it to his new one. I
used it, it worked great, and I heartily
recommend it to all who find a need
for a tool like it. But, those who
know me are aware that I can never
make a simple explanation of
anything. If you are easily bored, quit
reading now, if not read on.

I have a friend who has outgrown
her hard drive and needed a newer,
bigger one. I am sure that is a familiar
story to all of my readers.Yes, I told
her, I can do that for you. And yes
she wanted me to do that, not just
once but twice, once at the office and
again at home with the twin system.

The systems are about three years
old, Pentium 133, and came with 1.6
Gigabyte drives. Were they
compatible with large Ultra-DMA
hard drives? Yes, or the 1.6 would
not have worked. While I was at it,
could I upgrade the RAM to 32
megabytes. Sure why not. And could
I copy the old drive onto the new so
that she didn’t have to reload and re-

install all the software? Sure I can. So
I go to a club meeting and heard “Is
there anyone who might want to
evaluate DriveCopy Version 2?” My
hand shot up and the how of all this
was now determined.

My friend was going East for
about three weeks, but her office
would be open. She was having a

house/dog sitter so I could get to the
home system by contacting the sitter.
Before she left we took a trip to the
computer store and bought two 8.4
Gig drives. I also bought 2-32 Meg
PC 100 DIMMs and was all set.

First was the office system
because there was also a new HP
LaserJet to add memory to and install.
I  followed the DriveCopy manual and
prepared a floppy to run when I had
both drives installed. I also ran
ScanDisk and knew I had a clean
original or source disk. So, off  with
the cover and oh... am I surprised.
There are no DIMM sockets, only 30
pin and 72 pin SIMMs. And the hard
drive is securely fastened in with

screws on both sides. The back ones
behind the long motherboard. The
only solution that came to me was to
remove the cards and unfasten the
motherboard. Back to the computer
store for  EDO SIMMs which were
easy to install with the motherboard
loose. The 1.6 Gig drive had its
jumpering on the front of the drive, so
it had to come out,.Now I was ready
to mount the new (8.4 Gig) drive
jumpered as master and the old (1.6
Gig) drive as slave. Everything was all
set, I identified the two to CMOS via
autodetection but the 1.6 could not
be read. DriveCopy told me it either
had a bad FAT or a virus. I could not
go back to it as a master either. What
went wrong? Not the software, but
how did the drive go bad at just that
time?

Stories have to have a happy
ending! After a night of trying to figure
out how I was going to reload all that
software it hit me. Just go to my
friends’ home system and do the
upgrade on that system, Then bring
that 1.6 Gig drive back to the office
and use it as the slave to build the
8.4.

That worked beautifully on both
systems. The program ran about 45
minutes to copy to the new drive and
even set the partition active. There
are a few minor differences on the
two systems, like sound cards and
printers, but both are operational and
I am at peace.

DriveCopy 2 comes on a CD. The
program ends up on a floppy and is a
real jewel when you have a job like
this to do. It is also very well docu-
mented and easy to setup and use.

DriveCopy supports Windows 95/98,
Windows 3.1, Windows NT, DOS, and
OS/2. It costs $29.95  at stores, or
order it direct from http://
www.powerquest.com.

The safest, easiest, and most
affordable way to copy every-
thing from your old hard drive
to your new hard drive.
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New products & technology

(Continued on page 8)

Coping with cookies
by T. J. Lee, publisher
The Naked PC

The Naked PCer Dave pointed out
to me that way back in TNPC #2.09
I said, “Next issue I’ll sweep up the
cookie crumbs and point you at the
freeware utilities that let you instantly
hide all your cookies with the click
of a mouse.” Dave then took me to
task because I failed to do so. Dave
caught me dead to rights, but like the
kid whose dog ate his homework I
have an excuse.

The problem is that I was all set
to spout off about my favorite
solution for dealing with cookies, a
program called Anonymous Cookie
by Luckman Interactive. Only one
problem, when I went to check to
see if I had the latest version of this
free program, I found that Luckman
Interactive has disappeared. Gone,
poof, no forwarding address, end of
report. While the program is still
floating around various freeware
download sites I was not sure I
wanted to recommend a program
whose creator has pulled a cyber-
Houdini.

I really like Anonymous Cookie
because it lets you accept cookies
then disable every single cookie on
your machine with two mouse clicks.
You can then enable them again just
as easily. I like the flexibility and
control this gives me over cookies
and I can decide if I want to make
cookies available to a site at any
time. If you want to try the free
Anonymous Cookie knowing full
well it is an orphaned piece of
software, last time I checked you
can still find a copy at: http://
filedudes.nsiweb.com/win95/
cookies/setpacb2.html.

by Stan Leese

The original radio list we printed in November 1998 is out of date. Kim
Komando is only on two hours (pre-recorded) of her three hours on KLSX
(97.1)  on Saturdays from 10 a.m. to noon, and Sunday nights from 9 p.m. to
11 p.m. (same program). So, anyone attempting to call in  to (888) 825-5254
would have to do it from 7-10 a.m on Saturdays.  But fat chance getting
through on that national broadcast!  Better to send a note to www.helpmekim
@komando.com if one has a problem.

Also, there is no computer program from 4-7 p.m. on Sundays anymore (on
KABC 790).  I don’t have the original list, and can’t say I’ve checked on all of
them lately.  Jeff Levy is still on and I try and catch Kim’s recording and the
Earthlink Internet Hour on Sundays on KLSX  from 12:07 p.m. to 2 p.m.

Also, there is some computer show on KABC 790 am, that ends at 1 pm
on Sundays.  It conflicts with the Earthlink Internet Hour.  I don’t know when it
starts.  I will try and find out.

Schedule for computer radio shows is revamped

Top 10 computer bestsellers listed

1. HTML 4 for the World Wide Web: Visual QuickStart Guide
2. Flash 3! Creative Web Animation
3. Photoshop 5 for Windows and Macintosh: Visual QuickStart Guide
4. Perl and CGI for the World Wide Web: Visual QuickStart Guide
5. Illustrator 8 for Windows and Macintosh: Visual QuickStart Guide
6. Director 7 and Lingo Authorized
7. Dreamweaver 2 for Windows and Macintosh: Visual QuickStart Guide
8. The BeOS Bible
9. Director 7 for Macintosh and Windows: Visual QuickStart Guide

10. The Little Web Cam Book

In June, Adobe Press announced that its books will be distributed by
Peachpit Press. Individual user group members will automatically
receive a 20% OFF discount on Adobe or Peachpit Press books, in any
combination, when ordering up to 10 titles at a time. Shipping and handling is
$4 for the first book, and an additional $1 for each book thereafter; plus tax.

Individual user group members should call our general customer service
department at 800-283-9444 and specify they’re a user group member
seeking the special 20% off discount.

Adobe Press books include the Classroom in a Book series among other
titles. See Peachpit’s online catalog at http://www.peachpit.com.
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Computer and software tips

T.J. Lee is coauthor of The
Unofficial Guide to PCs,
Word 97 Annoyances, and
other popular computer
books.Contact him at
tj_lee@
TheNakedPC.com, or
subscribe free to The
Naked PC at http://
www.TheNakedPC.com/subscribe.html.

Copyright © 1999, PRIME Consulting
Group, Inc. and Dan Butler. All Rights
Reserved.
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In July 1976, a new computer kit
called Apple I was delivered to
retailers. The suggested price was
$666.66. In order to raise money to
produce their
single-board
computer,
Steve Jobs
sold his VW
van, and Steve
Wozniak sold
his program-
mable
calculator.
They raised $1,350.

A July 1999 report said strong sales
of iMac computers drove Apple
Computer Inc. to its seventh
consecutive profitable quarter.  The
company’s quarterly revenue,
ending June 26, was $1.56 billion.

I’ve started looking for a
replacement for Anonymous Cookie
for my own system but so far I can’t
find a clear winner. At least not one
that has the features of Anonymous
Cookie and is free to boot.

One freeware contender is
Cookie Cruncher from Rendering
Better Avenues. This application lets
you view and remove cookies in IE
and Navigator, http://
www.rbaworld. com/Programs/
CookieCruncher/index.shtml.

Another is Cookie Pal from
Kookaburra Software. This one is
shareware and costs $15 to register
after the 30-day evaluation. Cookie
Pal is feature-rich, letting you
configure it to accept cookies from

Coping with cookies

(Continued from page 7)

some sites while rejecting them from
others. It also lets you view and delete
cookies in both IE and Navigator,
http://www.kburra.com/cpal.html.

Dealing not only with cookies,
interMute professes to block annoying
banner ads as well. It’s a $20
shareware package with a 14-day free
trial version. The program looks very
promising although their Web site lacks
solid feature infor-mation, http://
www.intermute.com/overview.htm.

For now I’m still running Anony-
mous Cookie. If you have a favorite
Cookie manager drop me a line and let
me know why you like it. I’ll pass your
comments along in future issues.

Computer vComputer vComputer vComputer vComputer vocaocaocaocaocabbbbbularularularularularyyyyy

TCP/IP
(Transmission Control Protocol/

Internet Protocol)

Developed by the U.S. Dept. of
Defense, TCI/IP is a language which
governs communications among
computers on the Internet.

TCP and IP are two separate
protocols that are used together. IP
says how information must be sent
on the network in small data
packets; and TCP checks packets
for errors and reassembles them
at the destination.

Is your taskbar clock
losing time?

by Linda Gonse

How often have you found your
Windows 95/98 taskbar clock out of
synch with the correct time? Although
a weak CMOS battery may be the
culprit in some cases, there are also
several other reasons your taskbar
clock may lose time.

For instance, did you know the
clock stops when you change the
year in the Date/Time box until you
click Apply or OK?

If you change the month and date
often, the clock may lose significant
amounts of time. Microsoft support
estimates the current time is
decreased by 5 to 10 seconds when
you select a month or date.

Time can also be lost when you
use a third-party program to synch-
ronize your clock with another. One
example is when you coordinate with
an atomic clock on the Internet.

Another time loser occurs when
you use the Johnny Castaway screen
saver. Although it’s seldom seen these
days, it can cause resource leaks. The
leaks result in time loss.

But, the most surprising cause of
lost time is due to resizing the taskbar.
This can stop the clock until the
computer is restarted.

Two solutions exist for these prob-
lems: 1. Double-click on the clock in
the system tray and reset the time.
2. Go to Start/Programs/MS-DOS
Prompt. Type time. Press Enter.
Check the computer’s time. Press
Enter twice, type exit, press Enter. (If
the time was wrong, your computer’s
battery may need to be replaced.)
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I installed Norton System Works and
then tried to use their uninstaller
program which they call CleanSweep.
It didn’t work the way I had ex-
pected. Here’s the exchange that I
had on the Internet with technical
support.

Author: Ed Hughes
Date: 05:34 PM, Mar 31 PST
CleanSweep version: 4.5
I have just installed Norton System
Works 2.0. I had tried to use
CyberMedia Uninstaller 4 to make
room enough on my hard drive to
install Norton System Works 2.0. I
finally succeeded, but noted that
the uninstaller left a lot of McAfee
Virus Shield (or whatever) on the
hard drive. The NDW Users Guide
states than an orphan, “is a file
that is not part of a registered
program.” Or something like that.

I uninstalled Uninstaller 4 with
CleanSweep, but it didn’t take all
the files out of the folder. It refused
to take out several of the *.exe
files, but it also took out some.

I used Cleanup to try to clean
up the orphans. It showed me
some dll’s, but nothing from either
McAfee or Uninstaller. These files
are unusable and taking up
precious hard drive space. How
can I get rid of them?

Author: James Wonta (Symantec)
Date: 09:18 AM, Apr 01 PST
Hello Ed,
The following Knowledge Base
article explains which applications
Symantec recommends not
uninstalling using Norton
CleanSweep. Both of the applica-
tions you have mentioned in your

Why didn’t they tell me?

post are included in the Knowledge
Base article. We recommend rein-
stalling the applications then using
Add/Remove Programs to uninstall
them.

So I clicked on the URL to the
article which follows:

Technical Support Knowledge Base

Applications Not Recommended
to be Monitored, Uninstalled, Moved
or Transported by CleanSweep

We do not recommend monitoring,
uninstalling, moving or transporting the
following with CleanSweep:
• Microsoft Plus! Pack
• Microsoft Office Suite
• Corel Suite
• WordPerfect Suite
· Lotus SmartSuite
• Internet Explorer
•  Norton Utilities
• Norton SystemWorks
• Norton AntiVirus
• McAfee ViruScan
• Encryption programs, such as

Norton Your Eyes Only
• Development programs such as

C++, Visual Basic, Borland Delphi,
etc.

• Uninstall programs, such as
 Norton Uninstall Deluxe,
Uninstaller and Remove-It
There are certain .DLL and other

files that will be removed from other
applications if CleanSweep uninstalls
these types of programs. This is
because the file extensions are linked
to these secondary applica-tions.

In addition, these types of
programs integrate themselves very
deeply into Windows. You risk
corrupting your system if you let
CleanSweep uninstall them.

Product(s): CleanSweep 2.0,
CleanSweep 3.0, CleanSweep 4.0,
CleanSweep 4.10, CleanSweep
Deluxe 3.0x, Norton CleanSweep 4.5

Operating Systems(s): Windows
3.x, Windows 95, Windows NT 4.0,
Windows 98

Document ID: 1998120111525626
Date Created: 12/03/98
Last Modified: 02/18/99
Well, I was a little miffed! There is

no mention in the User’s Guide or the
README file that they always show
you after the product has been install-
ed, about restrictions on the use of
this program. I, of course, had
thrown away the CD’s. Fortunately,
the trash had not  been picked up and
I was able to retrieve the CD’s for
both McAfee and Uninstaller.

I reinstalled McAfee. Then I went
to the Control Panel, Add/Remove
Programs and clicked on McAfee
Viruscan. There were the usual con-
firmation windows and everything
seemed to be going well for a few
seconds, but then there was the win-
dow with the message, “Windows
encountered a problem removing
McAfee Viruscan. It was not
removed.”

So I first backed up the Registry.
Then I took the bit in my teeth,
opened Norton’s Registry Wizard
and looked for all the occurrences of
“McAfee.” I found one reference to
McAfee Viruscan. I deleted it. Then I
went to Windows Explorer and
deleted the McAfee folder.

I didn’t even try to reinstall
Uninstaller 4. I used the Registry
Wizard to find and delete all the
references to Uninstaller and deleted
them. There isn’t any “Select All”
under Edit. I had to do them one at a
time. Then I deleted the Uninstaller
folder.

Well, I hope I didn’t do anything
(Continued on page 10)

by Ed Hughes, Space Coast PC Users Group
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Peripherals

Charlie Moore, Chuck Moore, Don
Gonse, Ed Hughes, Fred Coad, Halsey
Minor, Ken Fermoyle, Linda Gonse,
Mike Lyons, Paul Stephen,  Stan Leese,
Ted Wirtz, T.J. Lee,  Willard La Mont.

Newsletter contributorsNewsletter contributorsNewsletter contributorsNewsletter contributorsNewsletter contributors

foolish. If I did, I’ll let you know.
Then I thought I would use

Norton CleanSweep to get rid of
unused DLL files. It showed me a list
of over two hundred of the files that,
according to CleanSweep, had no
known connection to any application.
These files occupy over fifty-six
megabytes of hard drive space.

Fortunately, as I stepped through
the long list of files, CleanSweep gave
me a description of the file. I found a
couple left over from ProComm Plus,
and an old LaserJet program. Neither
application has been on my computer
for years! I deleted them.

The total disk space recovered
was about half a megabyte.

Why didn’t they tell me?

(Continued from page 9)

I use Navigator for research and
other quick-and-dirty surfing, IE for
normal Web wandering when I want
to see all the graphics.

©1999 Ken Fermoyle, Fermoyle Publications

Ken’s Korner is available
to User Groups without
charge. For reprint permis-
sion, write kfermoyle@
earthlink.net.

Ken’s Korner

(Continued from page 5)

by Halsey Minor
CNET Founder and CEO

CNET auctions maintain a team of
tech-product experts who continually
highlight the great deals available on
the service. Their expert guidance
helps you buy the right product at the
right price.

On each product page, you can
quickly and easily access the relevant
product reviews from our extensive
collection, so you can read just what
CNET’s editors think about that
product before you buy.

And if the product being auctioned
is new or almost new, you can, with a
simple click of your mouse, find the
lowest retail prices using our price
comparison service, which features
1.5 million prices on more than
135,000 products currently available
from 84 computer resellers.

If you are already an online
auction pro, you will appreciate the
fact that we let you rate buyers and
sellers, use an escrow service, and do

Buy products on live CNET Auctions!

all the things a great auction service
should enable you to do. CNET
Auctions, http://auctions.cnet.com,
has been more than a year and a half
in the making, and I think you’ll see
we’ve put in all the bells and whistles.
But as always, we are interested in
getting your feedback and ideas on
how to make it better.

Give a man a fish and he will eat for a
day, teach a man how to fish, and he
will sit in a boat drinking beer all
day…

Submitted by Ted Wirtz

Computershopper.com deal

TravelMate 330T notebook—for
$1,999 @ShopAcer New! One inch
thin and just 4.1 pounds with a full-
size keyboard, large active-matrix
screen, fast Pentium II performance,
combo FDD/CD drive. For a limited
time: FREE shipping! http://
cgi.zdnet.com/slink?5030. —LG

Did you know?

A July newspaper report listed 800
million pages on the Web. —LG

mailto:kfermoyle@ earthlink.net
mailto:kfermoyle@ earthlink.net
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Planning meeting set

The ORCOPUG planning meeting
will be August 19, at 7 p.m. at
Downey Savings and Loan, on the
corner of Bastanchury and Laguna, in
Fullerton. Meetings are held the third
Thursday of every month. Everyone is
welcome to attend. —LG

Members’ Web Pages
Gloria Bearss http://www.geocities.com/~glen-glo

Breed & Show Harlequin Great Danes

Jim Brubaker http://www.1homeseller.com
Discount Real Estate Services for
Buyers and Sellers of Homes

Vince Cimino http://www.pe.net/~capov
Model Airplanes

Linda Gonse http://basicbytes.com
PC Instruction, Newsletter Design,
Web Page Design and Maintenance

Sharon Graham http://home.earthlink.net/~shgraham/
Family Photos and Information

Dan Sheffield http://www.act-4.com
Educational CD-ROM Software

FREE Web listing for ORCOPUG members! Add your Web address!
Send your information to editor@orcopug.org

Ontrack presentation

(Continued from page 1)

Reprint PolicyReprint PolicyReprint PolicyReprint PolicyReprint Policy
User groups wishing to reprint
unaltered, uncopyrighted material,
with credit to the author and
Nibbles & Bits, are encouraged to
write: editor@orcopug.org. In
exchange for your newsletter’s
name and date of publication, ASCII
and image files will be forwarded
to you for the desired article(s).

by Linda Gonse

The Southwest Regional User Group
Conference, July 9-11 in San Diego
was a great opportunity to talk to the
software makers themselves and see
demonstrations of their latest products.
In several instances, they provided a
preview peek at products not yet
released. Exciting stuff!

Besides products, it was fast-
paced weekend with interesting
workshops and introductions to other
user groups, some as far away as
Sacramento and Nevada. About 250
user group members attended.

ORCOPUG was well represented
with seven members and one guest:
Tony Lake, Joe Duffner, Lloyd
Boutwell, Dan Cadish, Alan Jarrett,
Charlie Moore, Linda and Dan Gonse.

Food was unending! Adobe, Jasc,
Symantec, Intuit, PowerQuest,
Microsoft, and Corel saw to that.
They provided breakfast, lunch,
dinner, and even snack breaks.

Other companies handing out
information, prizes, and samples were

other data-related issues and will
demonstrate some of Ontrack’s
products. He will have free copies of
Data Advisor and Y2K Advisor for all
attendees. I am sure our group will
enjoy his presentation because he
loves to answer questions. He also will
bring some Mijenix products to
sweeten our raffle. See you there,
bring a friend!

SWUG: A great chance to see new products

Enfish Technologies, Inprise, Data
Hand, MGI Software, Wildflower
Productions, Klassic Specialties,
Alps, Wild File, Meta Creations,
MicroSeconds, Get Into Your Family
Tree, Laser Perfect, Imation,
Macromedia, Voice Pilot, Street
Wizard, and NextGen Development.

It was fun to talk to manufac-
turer’s representatives whose names I
had only seen in print. Several of
them obviously have achieved
celebrity status based on the applause
they received on film and at
presentations by users familiar with
their great service. Among the “stars”
were Richard Katz from Intuit, Gene
Barlow from PowerQuest, and
Louise Miller from Adobe.

A partial list of workshop topics
were: Computer Fraud, Newsletter
Design and Layout, Scanners/Paper,
Publicity, and Hard Drive Facts.

Next year, send in your
registration and give SWUG a try!

Saturday,
August 21

or sooner, please

Sept.
NewsletterNewsletterNewsletterNewsletterNewsletter
DeadlineDeadlineDeadlineDeadlineDeadline

An understandable explanation of how
Y2K affects personal computers is at
Ontrack’s site. Go to http://
www.ontrack.com/op/op_6.asp and
scroll to the heading “Understanding
the Millennium Bug.”

http://www.geocities.com/~glen-glo
http://basicbytes.com
http://basicbytes.com
http://basicbytes.com
http://home.earthlink.net/~shgraham/
http://home.earthlink.net/~shgraham/


The Orange County IBM PC Users’ Group regular meeting is scheduled for the second
Tuesday of the month at 6:30 p.m. at the Hunt Library, 201 S. Basque Avenue, Fullerton,
(714) 738-5364.

Directions: From the 91
Freeway, exit at either
Euclid or Brookhurst
Streets and go north. Turn
onto Valencia Drive. Go to
Basque Avenue and turn
north. The Hunt Library is
located at end of Basque.
(Access only from
Valencia.)

Computer users
helping one another
Orange County
IBM PC Users’ Group
Post Office Box 1779
Brea, California 92822

★
Orange County

IBM PC
Users' Group

ORCOPUG

TTTTTuesda uesda uesda uesda uesdayyyyy
August 10 August 10 August 10 August 10 August 10
6:30 pm 6:30 pm 6:30 pm 6:30 pm 6:30 pm

Bring a friend!

Rebates to three Symantec programs, trial offers,
news briefs, links, Windows tips and Y2K updates…

Click on HOT NEWS at www.orcopug.org!

"""""
NNNNN

For more information, call (714) 990-0580, or go to www.orcopug.org.

Ontrack
at

meeting!

SWUG 1st prize
won by N&B

see page 2


